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Abstrak 
Augmented reality merupakan penggabungan benda-benda nyata dan maya di lingkungan 

nyata, berjalan secara interaktif dalam waktu nyata, dan terdapat integrasi antar benda 

dalam tiga dimensi, yaitu benda maya terintegrasi dalam dunia nyata.Dengan bantuan 

teknologi Augmented Reality lingkungan nyata disekitar lingkungan akan dapat berinteraksi 

dalam bentuk digital (virtual). Salah satu implementasi AR digunakan sebagai media 

pembelajaran Anatomi Tubuh Manusia. Implementasi ini dibangun dengan memasukan 

teknolog Augmented Reality berbasis android ke dalam sebuah gambar yang menarik 

sebagai alat bantu untuk media pembelajaran bagi pelajar SMP kelas VIII agar lebih 

memahami dalam mata pelajaran Biologi mengenai Anatomi Tubuh Manusia dan lebih 

menarik minat belajar bagi para siswa, sehingga maksud dan tujuan yang dimaksudkan oleh 

penulis dapat tersampaikan. Pada aplikasi ini juga terdapat animasi sistem reproduksi, 

animasi sistem pencernaan dan animasi sitem peredaran darah. Untuk pembuatan aplikasi 

dibutuhkan beberapa software yaitu Unity, Blender, Microsoft Paint, SDK Android, 

Qualcomm Vuforia SDK. Sedangkan untuk menjalankan aplikasi membutuhkan smartphone 

Android dan marker. 

 
Kata kunci: Anatomi tubuh,  Augmented Reality, Marker, Android 

 

1. PENDAHULUAN 

Anatomi adalah ilmu yang mempelajari tentang struktur tubuh manusia, berasal dari bahasa 

yunani “ana” yang berarti habis atau keatas dan “tomos” yang berarti memotong atau mengiris. 

Maksudnya anatomi adalah ilmu yang mempelajari struktur tubuh (manusia) dengan cara 

menguraikan tubuh(manusia) menjadi bagian yang lebih kecil kebagian yang paling kecil, dengan 

cara memotong atau mengiris tubuh(manusia) kemudian diangkat, dipelajari, dan diperiksa 

menggunakan mikroskop. Anatomi tubuh manusia disusun kedalam beberapa bagian tubuh, yaitu 

sistem kerangka, sistem otot, sistem peredaran darah, sistem pernafasan, sistem indra, sistem 

pencernaan, sistem urinaria, dan sistem reproduksi. Oleh karena itu penulis ingin mensimulasikan 

sistem anatomi tubuh dengan pemanfaatan teknologi Augmented Reality. 

Augmented Reality adalah teknologi yang menggabungkan benda maya dua dimensi dan 

ataupun tiga dimensi kedalam sebuah lingkungan nyata tiga dimensi lalu memproyeksikan benda-

benda maya tersebut dalam waktu nyata. Tidak seperti realitas maya yang sepenuhnya 

menggantikan kenyataan, namun Augmented Reality hanya menambahkan atau melengkapi 

kenyataan. Saat ini Augmented Reality dapat di implementasikan di beberapa media diantaranya 

adalah aplikasi pada desktop, smartphone, dan website. Penelitian ini berjudul“Augmented Reality 

pada Aplikasi Anatomi Tubuh Manusia (Sistem Reproduksi, Sistem Pencernaan, dan Sistem 

Peredaran Darah) berbasis Android”. Sebagai media pembelajaran untuk pelajar smp kelas VIII 

tentang anatomi tubuh manusia. 

 

2. METODE PENELITIAN 

Pembuatan media pembelajaran tentang anatomi tubuh manusia khususnya sistem reproduksi 

wanita, sistem peredaran darah, dan sistem pencernaan, media ini berbasis Augmented Reality yang 

berjalan di smartphone, dengan menggunakan metode marker based tracking, dan penggunaan 

camera minimal 5 MegaPixel. Media pembelajaran yang berbasis AR di peruntukan kepada Siswa 

sekolah menengah pertama kelas VIII dalam mempelajari ilmu anatomi tubuhmanusia. 

Pembuatan animasi 3D dengan blender, pembuatan marker kemudian marker tersebut di 

upload ke Vuforia. Banyak marker yang akan dibuat sebanyak tiga marker, marker pertama 
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digunakan untuk sistem reproduksi, marker kedua digunakan untuk sistem pencernaan, marker 

ketiga digunakan untuk sistem peredaran darah, cara menampilkan suara di AR Android, serta 

penggunaan smartphone atau pun tablet berbasis android untuk menampilkan animasi dalam 

bentuk Augmented Reality. 

 

Berikut adalah skema prinsip kerja Augmented Reality  sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

Gambar 1. Skema prinsip kerja Augmented Reality   

 

3. HASIL DAN PEMBAHASAN 

3.1. Analisa Masalah 

Aplikasi simulasi anatomi tubuh mencangkup sistem reproduksi, sistem peredaran darah, 

sistem pencernaan merupakan program aplikasi Augmented Reality yang ditampilkan pada 

smartphone Android dibuat dengan tujuan menjadi media pembelajaran bagi pelajar SMP kelas 

VIII agar lebih memahami dalam mata pelajaran Biologi mengenai anatomi tubuh. 

Aplikasi ini juga berisi tentang model-model tiga dimensi yang menggambarkan proses 

pencernaan makanan dimana makanan masuk melalui mulut dicerna oleh usus masuk ke usus 

halus, usus dua belas jari, usus besar lalu dikeluarkan melalu anus, sistem kerangka dimana di 

jelaskan tentang tulang, tulang tengkorang dan lainnya, dan sistem perdaran darah.  

Model-model tiga dimensi tersebut nantinya akan muncul diatas Marker (penanda khusus) 

yang telah ditentukan sebelumnyapada saat kamera smartphone diarahkan ke atas marker. Setiap 

maker akan menampilkan animasi dan menampilkan suara yaitu berupa penjelasan tentang animasi 

yang berbeda, karena aplikasi ini menggunakan tiga marker. Marker yang pertama menampilkan 

animasi struktur sistem kerangka, marker yang kedua menampilkan sistem peredaran darah dan 

marker yang ketiga menampilkan sitem pencernaan. 

 

3.2. Rancangan Pembuatan Aplikasi 

1. Desain Marker 

2. Pembuatan Marker 

3. Upload Marker ke Vuforia 

4. Pembuatan Objek 3 Dimensi 

- Pembuatan objek sistem reproduksi hingga pemberian texture. 

- Pembuatan objek sistem pencernaan hingga pemberian texture. 

- Pembuatan objek sistem peredaran darah hingga pemberian texture. 

- pembuatan animasi sistem reproduksi, sistem pencernaan, sistem peredaran darah. 

5. Cara membuat Augmented Reality dengan software Unity, cara menapilkan suara yang 

berisi penjelasan dari animasi yang ditampilkan serta pembuatan aplikasi dalam bentuk 

Augmented Reality pada smartphone android 
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3.2.1 Desain Marker 

Berikut ini adalah desain yang akan di buat untuk marker yang di gunakan di aplikasi ini. 

 

 

 

 

 

 

 

 

 

Gambar 2. Desain marker 

 Ket: 

1. Bingkai marker 

2. Text, nantinya akan diberi teks Marker 1, Marker 2, dan Marker 3 

3. Gambar/logo, sebagai pembeda antara marker 1, marker 2, marker 3. 

 

3.2.2 Pembuatan Marker 

 Pembuatan image tracker dilakukan dengan membuat marker di Microsoft Paint kemudian 

disimpan dalam bentuk image. Marker yang telah dibuat tersebut yang akan dijadikan sebagai 

image trackernya. Image hasil editanakan diupload ke website Vuforia Developer. 

 
Gambar 3.  Tiga Marker 

 

 

3.2.3   Upload Marker ke Voforia 

Untuk mengupload marker ke vuforia yaitu pertama buka website 

www.developer.voforia.com berikut langkah-langkah upload marker ke vuforia : 

1. Hal pertama yang di lakukan adalah login 

2. Setelah berhasil login maka akan masuk ke halaman target manager, kemudian klik create 

http://www.developer.voforia.com/
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database dan isi nama database lalu klik create 

3. Upload marker dengan klik add target kemudian isi nama marker, pilih jenis marker, 

tentukan ukaran marker dan pilih marker dari computer. Klik add jika sudah selesai  

4. Upload semua marker yang akan digunakan di aplikasi augmented reality, marker yang 

sudah berhasil di upload akan medapat reting dari vuforia yaitu berupa bintang-bintang, 

semakin banyak bintang maka semakin baik kualitas marker. 

5. Pada saat men-download pilih unity editor agar hasilnya dalam bentuk unity package 

 

  3.2.4 Pembuatan objek 3D 

Untuk membuat objek 3D menggunakan software blender . pembuatan objek 3 dimensi 

dibagi menjadi 3 tahap yaitu : 

1. Pembuatan Objek sistem reproduksi 

Pembuatan objek sistem reproduksi ini ada 3 tahapan , tahap pertama kita menjiplak dari 

gambar sistem reproduksi yang ada , karena bentuknya masih abstrak kita perhalus di 

subdivision surface, setelah objek sudah rapi kite beri warna texture supaya lebih terliahat 

real. 

 

 
 

Gambar 4. Objek sistem reproduksi 

2. Pembuatan objek sistem pencernaan 

Pembuatan objek sistem pencernaan sama seperti sistem reproduksi tidak ada yang di 

bedakan , cara pembuatannya kita ambil gambar sistem pencernaan yang sudah ada, kita 

jiplak , kalo gambar masih terlihat abstrak kita perhalus dengan subdivision surface lalu 

kita beri texture supaya terlihat lebih nyata. 

 

 

 
 

Gambar 5. Objek sistem pencernaan 

3. Pembuatan onjek sistem peredaran darah 

Pembuatan objek sistem peredaran darah sama juga seperti sistem reproduksi dan sistem 

pencernaan tidak ada yang di bedakan , cara pembuatannya kita ambil gambar sistem 

pencernaan yang sudah ada, kita jiplak , kalo gambar masih terlihat abstrak kita perhalus 
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dengan subdivision surface lalu kita beri texture supaya terlihat lebih nyata. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6. Sistem peredaran darah 

 

4. Pembuatan animasi  

Pembuatan animasi untuk sistem reproduksi, sistem pencernaan, dan sistem peredaran 

darah sama cara pembuatan animasi yaitu ubah tampilan dari Default menjadi Animation, 

kemudian tentukan time line dimana animasi akan dibuat. Untuk animasi sistem 

reproduksi, pertama atur time line di posisi 0 (nol). Klik I untuk lock keyframe kemudian 

pilih location, karena akan membuat animasi bergerak ke tempat yang kita inginkan, yang 

di mana per skalanya objek kita pindah klik I kemudian LocRotSkale , dan ini saya 

membuatnya menggunakan jalur, jadi disini yang saya pakai path untuk membuat jalur 

animasi geraknya. 

 

3.2.5 Pembuatan Augmented Reality Dengan Unity 

Berikut ini merupakan langkah-langakah pembuatan augmented reality dengan software 

unity sebagai berikut : 

1. Buka Unity klik File -> New Project Tentukan lokasi penyimpanan. 

2. Pilih File -> Build Settings pilih platform Android dan klik Switch Platform. 

3. Klik tombol Player Settings untuk mengatur tampilan pada saat di layar Android. Pada 

bagian Inspector -> Resolution & Presentation ubah default orientation menjadi 

“Landscape Left”, kemudian pada bagian Other Setting isikan Bundle Identifier dengan 

nama package “com.virusbakteriofage.pi”.  Ubah minimum API Level pilih Android 2.3.1 

(Gingerbread).  Buka Unity, klik Edit -> Preferences -> External Tools -> Android SDK 

Location -> tentukan lokasi install android-sdk. 

4. Setelah project baru dibuat langkah selanjutnya adalah memasukkan Vuforia SDK ke 

dalam project. Caranya cukup mudah, biarkan unity tetap terbuka. Double klik Vuforia 

SDK unitypackage maka akan muncul Importing package 

5. Setelah berhasil di import maka akan muncul isi dari package Vuforia SDK pada window 

project 

6. Untuk memasukkan marker ke Unity yaitu dengan cara mendownload marker yang telah 

diupload ke Vuforia seperti yang telah dijelaskan di bagian upload marker ke vuforia. Klik 

dua kali pada hasil download dan import marker tersebut. 

7. Untuk memasukkan objek ke Unity yaitu dengan klik Assets ->Import New Assets pilih 

objek yang akan dimasukkan. Pada aplikasi ini objek yang akan  dimasukkan yaitu objek 

sistem reproduksi, objek sistem pencernaan, dan objek sistem peredaran darah.  

8. Pada Aplikasi ini dibutuhkan 4 Scene, Scene yang pertama untuk tapilan Menu Awal 

aplikasi, Scene kedua untuk menampilkan AR  sistem reproduksi, Scene yang ketiga untuk 

menampilkan AR Sistem pencernaan, dan Scene yang keempat untuk menampilkan AR 

Sistem peredaran darah. 
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Gambar 7. Tampilan awal  

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 8. Scene sistem reproduksi 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 9.  Scene sistem pencernaan 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 10. Scene sistem peredaran darah 
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9. Penampilan suara  

Setiap animasi diberikan suara untuk menjelaskan animasi tersebut. Yaitu dengan merekam 

suara kemudian di import di Unity. Dengan cara klik Asset -> Import New Assets 

kemudian pilih suara yang akan di import 

 

 

 

 

 

 

 

 

 

 

Gambar 11. Import sound 

 

10. Jika semua Scene teleh berhasil dibuat, langkah selanjutnya yaitu membuat APK. Klik File 

-> Build Settings, drag semua scene yang tadi telah berhasil dibuat ke bagian Scenes In 

Build. Kemudian klik Build 

11. Tentukan dimana letak APK akan disimpan 

12. Langkah terakhir yaitu install APK di smartphone Android, dan jalankan aplikasinya. 

 

3.3  Hasil Ujicoba 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 12. Scane awal 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Gambar 13. Sistem reproduksi 
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Gambar 14. Sistem pencernaan 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

           Gambar 15. Sistem peredaran darah 

 

4. KESIMPULAN 

    Pembuatan Aplikasi Anatomi Tubuh Manusia Terdiri Dari Sistem Reproduksi, Sistem 

Pencernaan, Sistem Peredaran Darah dapat disimpulkan bahwa aplikasi ini sudah berhasil dibuat 

dan untuk membuat modeling menggunakan software Blender yang kemudian di eksport ke Unity 

3D dan tools yang digunakan untuk membangun aplikasi Augmented Reality adalah vuforia 

dengan menggunakan metode marker based traking. Untuk menjalankan aplikasi dibutuhkan 

perangkat bersistem operasi android versi Gingerbread ke atas. 

   Aplikasi ini telah dapat menjadi media pembelajaran untuk mengetahui dan membuat 

siswa khususnya siswa kelas VIII Sekolah Menengah Pertama dapat lebih memahami tentang 

Anatomi tubuh manusia dan menjadi lebih tertarik dengan pelajaran IPA. Selain itu, aplikasi ini 

juga telah membuat siswa lebih mengenal lebih dekat tentang teknologi masa kini. 

  Saran yang disampaikan dalam pengembangan aplikasi ini adalah memperbaiki siklus 

animasi dalam system reproduksi , animasi sistem peredaran darah dan dalam aplikasi ini penulis 

menyarankan lebih baik menggunakan camera 8 MegaPixel dan procecor minimal dual-core. 

Untuk pengembangan aplikasi ini bisa ditambahkan splash screen supaya tampilan lebih menarik 

lagi. 
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